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teyworgésl Sila jangan mengedit atau mengalih keluar sebarang teks atau
eywor . .
s i 10 e et objek yang diserlahkan dalam warna merah.
order. .
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(10 mata) Perenggan diteruskan dari sini dan hanya dipisahkan oleh tajuk, subtajuk, imej dan
formula. Tajuk bahagian disusun mengikut nombor, tebal dan 10 pt. Berikut ialah arahan lanjut
untuk pengarang.

Struktur Pemformatan MS Word

Fail hendaklah dalam format MS Word sahaja dan hendaklah diformatkan untuk percetakan
langsung. Angka dan jadual hendaklah dibenamkan dan tidak dibekalkan secara berasingan. Sila
pastikan anda menggunakan sebanyak mungkin fon biasa dalam dokumen anda. Fon khas, seperti
fon yang digunakan di Timur Jauh (Jepun, Cina, Korea, dll.) boleh menyebabkan masalah semasa
pemprosesan. Untuk mengelakkan kesilapan yang tidak perlu, anda amat dinasihatkan untuk
menggunakan fungsi 'pemeriksa ejaan' MS Word. Ikut susunan ini semasa menaip manuskrip: Tajuk,
Pengarang, Gabungan, Abstrak, Kata Kunci, Teks utama (termasuk angka dan jadual), Pengakuan,
Rujukan, Lampiran. Kumpulkan pengakuan dalam bahagian berasingan di akhir rencana dan jangan
sertakan mereka pada halaman tajuk, sebagai nota kaki kepada tajuk atau sebaliknya.

Senarai bertumpu boleh disertakan dan sepatutnya kelihatan seperti ini:
(i) Perkara pertama
(i) Perkara kedua
(iii) Dan sebagainya

Pastikan anda kembali kepada gaya 'Teks Utama', gaya yang akan anda gunakan terutamanya
untuk blok teks yang besar, apabila anda telah melengkapkan senarai bertumpu anda.

Tolong jangan ubah susun atur pemformatan dan gaya yang telah disediakan dalam dokumen
templat ini. Seperti yang ditunjukkan dalam templat, kertas kerja hendaklah disediakan dalam format
lajur tunggal. Jangan nombor halaman di bahagian depan, kerana nombor halaman akan ditambah
secara berasingan untuk pracetak dan Prosiding. Tinggalkan baris yang jelas di antara perenggan.
Semua templat gaya yang diperlukan disediakan dalam dokumen ini dengan nama yang sesuai
dibekalkan. Sila rujuk halaman 7 untuk panduan lengkap tentang gaya.

Jadual

Semua jadual hendaklah dinomborkan dengan angka Arab. Tajuk hendaklah diletakkan di atas
jadual, dibiarkan dibenarkan. Tinggalkan satu ruang baris antara tajuk dan jadual. Hanya garisan
mendatar harus digunakan dalam jadual, untuk membezakan tajuk lajur dari badan jadual, dan
betul-betul di atas dan di bawah jadual. Jadual mesti dibenamkan ke dalam teks dan tidak dibekalkan
secara berasingan. Di bawah ialah contoh yang mungkin berguna oleh pengarang.

Jadual 1. Contoh jadual (Fon = §; Klik 'Kapsyen A' pada Galeri Gaya)

Contoh tajuk lajur Lajur A (t) Lajur B (T)

Dan entri 1 2

Dan satu lagi entri 3 4

Dan satu lagi entri 5 6
Source:

Pembinaan Rujukan

Rujukan hendaklah disenaraikan di akhir kertas, hendaklah disusun terlebih dahulu mengikut abjad
dan kemudian disusun lagi mengikut kronologi jika perlu. Lebih daripada satu rujukan daripada
pengarang yang sama pada tahun yang sama mesti dikenal pasti dengan huruf "a", "b", "c", dan
lain-lain, yang diletakkan selepas tahun penerbitan.
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Beberapa contoh bagaimana rujukan anda harus disenaraikan diberikan pada penghujung templat
ini dalam bahagian 'Rujukan’ yang akan membolehkan anda mengumpulkan senarai rujukan anda
mengikut format dan saiz fon yang betul.

Tajuk Bahagian

Tajuk bahagian hendaklah dibiarkan dibenarkan, dengan huruf pertama menggunakan huruf besar
dan bernombor berturut-turut, bermula dengan Pengenalan. Tajuk sub-seksyen hendaklah dalam
huruf besar dan huruf miring kecil, bernombor 1.1, 1.2, dan lain-lain, dan dibiarkan dibenarkan,
dengan baris kedua dan seterusnya dilekukan. Anda mungkin perlu memasukkan pemisah halaman
untuk mengekalkan tajuk dengan teksnya.

Garis Panduan Am Untuk Penyediaan Teks Anda

Elakkan tanda sempang pada penghujung baris. Simbol yang menandakan vektor dan matriks
hendaklah ditunjukkan dalam jenis tebal. Nama pembolehubah skalar biasanya hendaklah
dinyatakan menggunakan huruf miring. Berat dan ukuran hendaklah dinyatakan dalam unit SI. Sila
tajuk fail anda mengikut susunan ini firstauthorname.docx.

Nota kaki

Nota kaki harus dielakkan jika boleh. Nota kaki yang diperlukan hendaklah dilambangkan dalam
teks dengan huruf superskrip berturut-turut. Nota kaki hendaklah ditaip satu jarak, dan dalam saiz
jenis yang lebih kecil (8pt), di kaki halaman di mana ia disebut dan dipisahkan daripada teks utama
dengan garisan pendek yang memanjang di kaki lajur. Gaya 'nota kaki' boleh didapati dalam templat
ini untuk teks nota kaki.

Gaya Rujukan Dan Petikan

Rujukan dan petikan manuskrip hendaklah ditulis menggunakan gaya edisi ke-7 APA. Dari segi
gaya petikan dalam teks, APA menggunakan nama keluarga pengarang dan tahun penerbitan,
contohnya: (Field, 2005); (Field & Thomas; 2014). Jika terdapat tiga atau lebih pengarang, sebutkan
hanya nama keluarga pengarang pertama diikuti dengan "et al." dan tahun., sebagai contoh: (Field et
al., 2017). Untuk petikan langsung, sertakan nombor halaman juga, contohnya: (Field, 2005, hlm.
14). Sila pastikan bahawa rujukan yang digunakan adalah terkini, khususnya dalam tempoh 5 tahun
yang lalu, terutamanya untuk rencana yang tidak bersifat klasik (turath).

Contoh rujukan boleh didapati di halaman 5. Sila rujuk laman web berikut untuk maklumat
lanjut mengenai gaya rujukan APA edisi ke-7: https://libraryguides.vu.edu.au/apa-referencing

Manuskrip al-Quran dan Hadis dalam format Microsoft Word:

Bagi sebarang tulisan yang mengandungi ayat-ayat al-Quran atau Hadis, sila sertakan hanya
terjemahan ayat tersebut bersama-sama dengan petikan yang diformat seperti berikut:

Untuk ayat-ayat al-Quran, sila gunakan format "Surah al-Fatihah, 1 (nombor surah): 3 (nombor
ayat)." Penyelidik mesti memasukkan teks Arab asal al-Quran menggunakan perisian ‘al-Quran in
Word” (Saiz fon 12) dalam artikel jika perlu. Sebagai contoh:

0 (aild AY; ME A0 ¢ Gl sz elle ¥ Sl a5
Terjemahan: Tuan Hari Penghakiman. Engkau (sahaja) kami menyembah, dan
Engkau (sahaja) kami meminta pertolongan. Bimbing kami di sepanjang Jalan
Lurus

Surah al-Fatihah, 1: 3-5

Bagi Hadis, sertakan matn (teks) menggunakan fon Arab Tradisional (saiz 12) dan terjemahan

hadis dengan petikan sekurang-kurangnya dalam format: "Dilaporkan oleh al-Bukhari: 1414
( dan Takhrij ringkas (Status Hadis)." Sebagai contoh:
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WAL 1T 40 Y 28 ¢ all (e BBRLANL a8 U450 Gah G Ll e gl

Ll 3355 QA3 48 G 4 A 8031 6001 A Sa050 UAT0 (5505 ¢ 4da
Terjemahan: Suatu masa akan datang kepada orang ramai apabila seseorang
mengembara dengan emas sebagai zakat dan tidak akan menemui sesiapa yang
menerimanya, dan seorang lelaki akan dilihat diikuti oleh empat puluh wanita
untuk menjadi penjaga mereka kerana kekurangan lelaki dan sebilangan besar

wanita.
Riwayat al-Bukhari: 14143

KARYA SENI PENGARANG

Semua angka hendaklah dinomborkan dengan angka Arab (1, 2,... n). Semua gambar, skema, graf,
dan gambar rajah hendaklah dirujuk sebagai angka. Lukisan garisan mestilah imbasan berkualiti
baik atau output elektronik sebenar. Imbasan berkualiti rendah tidak boleh diterima. Angka mesti
dibenamkan ke dalam teks dan semua imej harus memenuhi keperluan minimum 500 x 500 piksel.
Huruf dan simbol hendaklah ditakrifkan dengan jelas sama ada dalam kapsyen atau dalam legenda
yang disediakan sebagai sebahagian daripada rajah. Rajah hendaklah diletakkan di bahagian atas
atau bawah halaman seboleh-bolehnya, sedekat mungkin dengan rujukan pertama kepada mereka
dalam kertas.

Rajah

Gambar rajah boleh dalam bentuk rangka kerja, aliran proses, carta atau sebarang alat bantu visual
yang bertujuan untuk menyokong teks bertulis. Mana-mana gambar rajah yang dibina menggunakan
Microsoft Word atau Alat Grafik Seni Pintar Microsoft Power Point perlu dibenamkan sebagai objek
boleh diedit atau berasaskan vektor (bukannya objek imej). Gambar rajah yang dilampirkan
menggunakan imej berasaskan peta bit (jpeg., png., dan format lain) perlu dalam resolusi tinggi
(sekurang-kurangnya 300 piksel per inci).

Teks yang Dibenamkan dalam Gambar Rajah

Fon yang digunakan untuk label atau penunjuk di dalam rajah perlu diformatkan sebagai Times New
Roman dengan saiz fon ditetapkan pada 8. Ia tidak boleh tebal, condong atau digariskan.
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Rajah 1. (kiri) angka ini kabur, yang tidak boleh diterima; (kanan) angka ini mempunyai resolusi yang lebih tinggi.
Walau bagaimanapun, label tidak diformatkan menggunakan fon Times New Roman. (Fon = 8; Klik 'Kapsyen A'
pada Galeri Gaya)

Sumber: Pengarang (2025)

Sacm-seonomic fariory
Sociceconomic
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Rajah 2. (kiri) rangka kerja ini ialah gambar rajah yang tidak boleh diedit, kelihatan kabur dan oleh itu, tidak boleh
diterima; (kanan) rangka kerja ini dibina menggunakan alat ilustrasi MS Word, mempunyai resolusi yang lebih
tinggi dan boleh diterima. (Fon = 8; Klik 'Kapsyen A' pada Galeri Gaya)

Sumber:

Sila gunakan 'alat kanvas lukisan' dalam MS Word sebelum memasukkan sebarang imej atau
gambar rajah ke dalam dokumen. Apabila membina rangka kerja konseptual/teori, sila gunakan
gambar rajah yang boleh diedit atau berasaskan vektor. Lukis gambar rajah menggunakan Alat
Grafik Seni Pintar MS Word (kotak teks, label, anak panah, legenda, dll.) dan bukannya
membenamkan objek imej yang tidak boleh diedit. Pastikan semua angka mempunyai resolusi yang
baik (minimum 300dpi) dan tidak kabur atau kabur.

Kapsyen

Nombor angka dan kapsyen hendaklah ditaip di bawah ilustrasi dalam 9pt dan ditekankan ke kiri.
Karya seni tidak mempunyai teks di sepanjang sisinya dalam badan utama teks. Walau
bagaimanapun, jika dua imej muat bersebelahan antara satu sama lain, ini boleh diletakkan
bersebelahan antara satu sama lain untuk menjimatkan ruang, lihat Rajah 1. Mereka mesti
dinomborkan secara berturut-turut, semua angka, dan semua jadual masing-masing.

PERSAMAAN DAN FORMULA

Persamaan dan formula hendaklah ditaip dan dinomborkan secara berturut-turut dengan angka Arab
dalam kurungan di sebelah kanan halaman (jika dirujuk secara eksplisit dalam teks). Mereka juga
harus dipisahkan daripada teks sekeliling dengan satu ruang. Jika anda memilih untuk menggunakan
Editor Persamaan, sila pastikan manuskrip disimpan menggunakan format .docx (bukannya .doc),
dan Mod Keserasian dimatikan.

Rt = K EP = 93.02 (+9.62) — 13.45 (1)
PENGHARGAAN
Bahagian ini adalah wajib. Penulis diminta untuk menyatakan penghargaan kepada pihak yang

berkenaan dari pelbagai bentuk sama ada pembiayaan atau lain-lain.

Penulis ingin mengucapkan terima kasih kepada sokongan Universiti Teknologi Mara (UiTM),
Cawangan Negeri Sembilan, Kampus Kuala Pilah dan Fakulti Sains Gunaan, Universiti Teknologi
MARA, Shah Alam, Selangor, Malaysia untuk menyediakan kemudahan dan sokongan kewangan
untuk penyelidikan ini.

PENYATA KONFLIK KEPENTINGAN
Bahagian ini adalah wajib. Berikut ialah contoh kenyataan konflik kepentingan:

Penulis bersetuju bahawa penyelidikan ini dijalankan tanpa sebarang konflik kepentingan diri,
komersial atau kewangan dan mengisytiharkan ketiadaan kepentingan yang bercanggah dengan
pembiaya.

SUMBANGAN PENULIS

Sumbangan setiap pengarang mesti dinyatakan dengan jelas mencerminkan setiap sumbangan
kepada badan karya dan manuskrip. Pengarang boleh merujuk kepada CRediT (Taksonomi Peranan
Sumbangan) untuk maklumat terperinci tentang sumbangan individu kepada karya tersebut. Sebagai

contoh:

Jaya Subramaniam menjalankan penyelidikan, menulis dan menyemak semula artikel tersebut.
Rahmah Hassan mengkonseptualisasikan idea penyelidikan utama dan menyediakan rangka kerja
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teori. Rahmah Hassan dan Chong Ju Lian merancang penyelidikan, menyelia kemajuan
penyelidikan; Rahmah Hassan melabuhkan semakan dan meluluskan penyerahan artikel.

PENGISYTIHARAN PENGGUNAAN Al

1. Tiada Penggunaan Al: Penulis mengesahkan bahawa tiada sebarang penggunaan alat Al
dalam penjanaan kandungan artikel ini.

2. Al Sebagai Sokongan Sahaja: Penulis mengakui penggunaan alat Al [sila nyatakan
penggunaan, contohnya untuk penyelidikan latar belakang atau pembelajaran kendiri),
namun tiada sebarang kandungan yang dijana oleh Al disertakan dalam artikel ini.

3. Kandungan yang dibantu Al: Penulis mengakui penggunaan alat Al bagi tujuan penjanaan
atau bantuan dalam penghasilan kandungan yang disemak, disunting dan diintegrasikan
secara menyeluruh ke dalam artikel ini. Anggaran sumbangan kandungan yang dijana oleh
Al adalah sebanyak [sila nyatakan peratusan, mesti kurang daripada 20%].

RUJUKAN

Pengarang juga dikehendaki memetik sebaik-baiknya tiga (3) artikel atau sekurang-kurangnya satu
(1) artikel yang telah diterbitkan dalam JCIS.

Mettam, G. R., & Adams, L. B. (1994). How to prepare an electronic version of your article. In B. S.
Jones, & R. Z. Smith (Eds.), Introduction to the electronic age (pp. 281-304). New York:
E-Publishing Inc.

Strunk, W., Jr., & White, E. B. (1979). The elements of style. (3rd Ed.). Macmillan.

Van der Geer, J., Hanraads, J. A. J., & Lupton R. A. (2000). The art of writing a scientific article.
Journal of Scientific Communications, 163(1), 51-59.

Dusuki, A. W. & Dar, H. (2007). Stakeholder's perceptions of corporate social responsibility of
Islamic banks: Evidence from Malaysian economy. In M. Igbal, S. S. Ali & D. Muljawan (Eds.),
Proceedings of the 6th International Conference on Islamic Economics and Finance (pp. 249-277).
Jeddah, Saudi Arabia: Islamic Development Bank.

@ @ © 2026 by the authors. Submitted for possible open access publication under
@ the terms and conditions of the Creative Commons Attribution (CC BY SA)

license (https://creativecommons.org/licenses/by-sa/4.0/).

CONTOH LAMPIRAN

Pengarang termasuk bahagian lampiran harus berbuat demikian selepas bahagian Rujukan. Pelbagai
lampiran semuanya harus mempunyai tajuk dalam gaya yang digunakan di atas. Mereka secara
automatik akan dipesan A, B, C dan lain-lain.

A. Contoh tajuk dalam lampiran

Al Contoh sub-tajuk dalam lampiran

https://doi.org/10.24191/jcis.v11i1.1©Authors, 2026
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Terdapat juga pilihan untuk memasukkan subtajuk dalam Lampiran jika anda mahu.

Maklumat Pengarang

Sila serahkan fail berasingan lain dengan menamakannya sebagai "Maklumat Pengarang". Elakkan
mendedahkan identiti dan maklumat pengarang dalam manuskrip (yang sepatutnya tanpa nama).
Sediakan maklumat berikut dalam fail yang dipisahkan.

Pengarang 1 (Nama Penuh, tanpa Tajuk/Jawatan), Sila ringkaskan latar belakang akademik dan
butiran pengarang dan maklumat hubungan (alamat e-mel adalah wajib). Maklumat biografi
pengarang akan dipaparkan selepas Senarai Rujukan. Bilangan maksimum perkataan ialah 100.

Nama Penuh Pengarang 2 (Nama Penuh, tanpa Tajuk/Jawatan), Sila ringkaskan latar belakang
akademik dan butiran pengarang dan maklumat hubungan (alamat e-mel adalah wajib). Maklumat
biografi pengarang akan dipaparkan selepas Senarai Rujukan. Bilangan maksimum perkataan ialah
100.

Sebagai contoh:

Danial Rashid, PhD ialah Profesor Madya di Jabatan Pengurusan dan Kewangan di Universiti
Nusantara. Aktiviti penyelidikan utama beliau adalah dalam bidang inovasi organisasi dan
pembelajaran organisasi. Beliau telah menerbitkan secara meluas mengenai subjek ini dalam
penerbitan seperti Jurnal Antarabangsa HRM, Pengurusan Pemasaran Industri, Jurnal

Penyelidikan Perniagaan, Jurnal Antarabangsa Pengurusan Maklumat dan Keputusan Pengurusan.
Dia boleh dihubungi melalui e-melnya di danialrashid@nusantarauni.edu.my.

Pemformatan Gaya: Arahan Khas kepada Pengarang (Sila baca ini)

e Pengarang dikehendaki mengedit templat menggunakan Microsoft Word 2010 dan
seterusnya.

e Pengarang mesti menggunakan ' Styles Gallery ' untuk memformat kandungan bertulis
artikel.

e ‘Styles Gallery’ terletak di dalam Reben ‘Home’, dalam Panel ‘Styles’.

https://doi.org/10.24191/jcis.v11i1.1©Authors, 2026
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Home tab Applied Style Text Style Gallery
(3 d - ¢ s )
B o e g - @
) Combria Hesgngn = %

B J U-dex x 4
“W A da AW
woard T Fent ] Faesgragh

v
On the Insert tab, the galleries
include items that are designed «

coordinate with the overall look of your document. You can use these galleries to insert
tables. headers, footers, lists. cover pages. and other document building blocks: When you
create pictures, charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a
| lookfor the selected text from the Quick Styles gallery on the Home tab. You can also format
text directly by using the other controls on the Home tab. Most controls offer a choice of =]
.I using the look from the current theme or using a format that you specify directly.

: To chanze the overall lock of vour document. choose new Theme elements on the Page <

Pagelefl | Words 135 | o5 Enghghjuk) | insen | 2]

H3 3 E U - +!

e 'Styles Gallery' muncul seperti berikut:
e Sila gunakan Galeri Gaya semasa memformat artikel anda.
o Sila elakkan melakukan perkara berikut:

o  Laraskan parameter perenggan

o  Tambah penomboran pada tajuk

o  menambah atau mengurangkan lekukan

o  Buat tajuk baharu

° Jika pemformatan kelihatan menyimpang daripada keperluan, pilih perenggan/tajuk yang
terjejas, dan klik ikon " Clear Formatting " di bahagian 'Font' di dalam seksyen 'Home'

TimesMewRo - {10 - A™ A”  Aa- z%;.— ‘ﬂ
&

B IU-a x,¢ A -2 -A-

Font Fa

° Pemformatan akan ditetapkan semula. Sekali lagi, gunakan pemformatan yang
dimaksudkan dengan mengklik gaya tertentu menggunakan Galeri Gaya.

AsBbCeDdl  AsBHCeDME: AaBbCeDdl AaBhCeDd 1.7 AaBbC 11] AaBi AsBbCcDé AaBbCeDé AABD( 4 4aBC A1 AaBb
Abstract  TCaption A CaptionB  Heading A HeadingB  Heading C | Main Text | Reference Title zAppendix.. zAppendix.. +

]

Styles
Sila rujuk jadual di bawah untuk memahami penggunaan sasaran setiap gaya tertentu.

Nama Gaya Penggunaan yang Disasarkan

Title Tajuk utama
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